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BEST PRACTICES COURSE – WEEK 21 – Creating and Customizing 
Library Parts PART 5 - Importing 3D IFC and DWG Files to Create 
Library Parts 
 

Hello, this is Eric Bobrow.  In this ArchiCAD video tutorial, I will show you how you can import 

manufacturer's objects in IFC and DWG formats.  These are becoming increasingly more available as 

more manufacturers are realizing that architects and building designers are using 3D BIM software for 

their design.  [0:00:27] 

This topic came up recently as a question from architect Tim Ball in the United Kingdom, in our ArchiCAD 

coaching program, part of the Best Practices course.  He sent me this e-mail and mentioned that in the 

UK there is a national BIM library that has started to compile, publish and make available many 

manufacturer's objects. He wondered about how he could import things that were in IFC format.  He 

also referred me to another website for a hand basin from another manufacturer.  [0:01:03] 

So let's take a look at how this works.  I will go to the website for the national BIM library.  This is just 

one of many websites nowadays that have 3D architectural objects, primarily from manufacturers, that 

are in a variety of formats.  So if we look at the BIM content here, you will see that we can look at say 

sanitary appliance systems and see different types of plumbing fixtures, toilets, etcetera.  And the one 

that he asked me to look at, just as an example, is the cleaner sink.  [0:01:40] 

So if I click on this you will see that it brings up more information about it. There's actually a user guide, 

which I can show you here.  Actually this is a preview image of what it will look like, and then here is a 

user's guide.  Now the user's guide indicates that this was created in Revit and has many different 

parameters that could be adjusted in Revit, but there are also versions available for ArchiCAD and other 

BIM software. [0:02:11] 

Now as it turns out, on the current site there is IFC, which is the general format that we will be able to 

use, and Revit.  So I'm going to go and say that I would like to download this. It says which format. I will 

say IFC and click on the Download button.  It then basically will download a .zip file that I can go ahead 

and save and then open up, expanding the .zip file.  Let me switch to ArchiCAD and show you how we 

bring this in.  [0:02:40] 

In ArchiCAD 16, there have been improvements in many different areas.  One of them that may have 

actually come before 16 - it may have been in 15, I'm not quite sure - is the ability to go to the File 

menu, File Special, Merge command. Then you can actually bring in an IFC file.  So I'm going to go to my 

Downloads here and you can see that I had previously downloaded this file - actually this is the .zip file 

here. Here I have expanded it, and here is the actual IFC file that I'm going to bring in.  So this is the 

actual object. Here is that user's guide that I referred to.  [0:03:21] 
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I'm going to open up the object here, and when you highlight an IDC object that is designated as a 

plumbing or mechanical fixture, ArchiCAD will ask you if you would like to use the MEP library.  So the 

MEP add-on for ArchiCAD is an optional add-on that allows you to place and route plumbing and heating 

duct work, plumbing, piping, and electrical cable trays I believe.  I don't have the MEP add-on installed in 

my copy of ArchiCAD, so I can ignore that. I can basically say no, I don't want to find the MEP library.  If I 

did have it, then it would actually bring this in and designate it in its proper category, which would be a 

fixture for the water system. [0:04:14] 

Since I said no, it's just bringing it in as a standard object which is fine.  I'm going to place this at the 

offset of zero, which means it's going to be on the ground level. And you can see that it showed up in 

just the lower left here.  I didn't really get a chance to place it but of course I could select it and move it 

to a new position.  However you'll notice that the dots here are gray and I can't move it immediately. 

That's because it's on a layer that was added into the layer list when I imported it. [0:04:45] 

You can see that it has a designation related to the IFC object and that it's an import; and it was brought 

in locked at that time.  One of the things about IFC in general is that it's used often for collaboration in 

building models. If you were bringing it in with a structural model from structural consultants, then it 

would actually make sense when merging that in for it to be locked, so that you wouldn't inadvertently 

move the structural model in relationship to its coordinate placement. [0:05:21] 

In this case, I would like to experiment with this. So I can go right click on this and go to the Layers and 

say Unlock Layer. That will then give me the proper handles here.  Regardless of whether or not it's 

locked, if I go to 3D we will see that it came in and it looks pretty good immediately.  And I can select it 

here in 3D. You can see that it's one element.  It actually has snap points. You can see the snap points in 

the corners here.  This would be I presume the sort of bounding box of the basin. There are intelligent 

hot spots that came in along with this IFC object. [0:06:02] 

Actually, even though the floor plan object only has the basic bounding box and center hotspots, in 3D it 

has some more snap options, which is good.  Notice that this symbol is a little bit odd.  That's because 

the actual bottom of the basin sink is not totally flat.  Of course it drains to the opening here.  If I would 

like to get this symbol to be more correct, and in fact just clean it up because you can see a lot of other 

lines in there, we can take advantage of one of the capabilities of ArchiCAD 16 which is the ability to 

turn this or turn a copy of it into a morph.  [0:06:46] 

So I'm going to go drag a copy of this over to the side here.  Press and release the Option key or the Ctrl 

key on Windows, and you'll get a copy.  I will select this and go to the Design menu and say that I would 

like to convert the selection to a morph.  When I do that, it tells me what it's going to do, that it's going 

to be converted to a morph, and the original element will disappear as well as any dimensions that we 

are referring to.  As soon as I do that, you can see it changes slightly in terms of color. [0:07:24] 
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If I go to 3D, we will see that element is still there just the same as before.  If I select it, you'll notice that 

it's selecting the basin here but not the legs.  That's because it's actually been converted into multiple 

morphs.  If I draw a bounding box rectangle around it, you can see that there are seven morphs.  So the 

one object was broken up into seven pieces. [0:07:51] 

If I want to be able to deal with is conveniently, for example, if I wanted to drag this around, you can see 

that this is only one of those elements.  So what I would probably want to do is select all of these and 

group them like this.  Now, if I select this and drag it, you'll see that it drags the entire batch of 

elements.  Now I'm going to suspend groups and just select this main morph here.  Actually let's just 

click it from the corner, and I'll use an option to smooth this out.  [0:08:37] 

So under the Design menu, Morph Settings, we're going to open up the settings here and you can see 

that the edges can be hard, where we are seeing these extra lines, hidden, or soft.  I will use the soft 

option here and what that will do is it will only show lines where it needs to.  So I'll say OK.  And you can 

see now the symbol for the basic floor plan representation looks much better.  When I go to 3D, you can 

see that it actually looks quite a bit different.  [0:09:12] 

Even in the 3D window, it's smoothing out this surface.  The surface still has the same polygons, but it's 

been told to smooth this in terms of rendering.  Now we could go and select these other elements and 

do the same thing.  There several of them in here, and I could go into all of these morphs and make 

them soft.  Then it may clean up just a little bit better in certain areas.  This is optional; you need to play 

around with it to see what it does and whether you like the effect of that. [0:09:52] 

Now that I've actually switched these around, let's turn this into an object.  So I'm going to take these 

elements and I will go to the File menu, Libraries and Objects, and say Save Selection As, Object.  So I am 

here on the floor plan and I'm going to be saving all of the elements that I've selected as an object.  So 

we will call this "NBL Sink".  And I'm going to put it into the embedded library so it will be part of this 

project.  Or I could save it out to a folder on my hard drive for use in multiple projects.  Or I can have it in 

this project and then later export it using Library Manager. [0:10:33] 

So I will save this and you'll notice that it gives me some options that are part of ArchiCAD 16. We'll 

actually get into that later in this tutorial.  Right now I am just going to say OK.  We don't see any change 

here because basically it has defined a new object and loaded that into the Object tool.  So now if I place 

this - perhaps I want to change it from the furniture layer to the equipment layer - I will just click and 

place this.  Now you can see that this is a single element, NBL Sink, the one I created. [0:11:05] 

If I go to 3D you will see it is now showing up and it is as we would expect; a single element here.  It 

doesn't have all the same hotspots as it did before, but perhaps that's not necessary.  And what is nice 

about this is its going to give a clean representation on the floor plan and in 3D views.  In fact, if we were 
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to take an elevation view of this, and I believe this one would probably point at it here, you can see that 

it's a very nice, clean representation.  [0:11:41] 

The reason why the other elements aren't showing up is because the layers that they were put on were 

not set up in the layer combination.  So I need to turn on the layer for the original object.  Remember 

that we had unlocked it. And I think that's probably all that I need to do is change this here for the 

sections.  And perhaps I will also make it so that these elements here are showing on the floor plan and 

on the plumbing plan.  Let's say OK. [0:12:14]  

So now you can see the original element had these facets whereas the new element is much cleaner.  So 

remember, this was the original that I imported from IFC.  The middle one is actually a series of morphs.  

If I select it, you can see here is a morph; here is another morph.  And then this is the new object that is 

very cleanly being represented.  You notice when I select it we can see the hidden geometry, but when I 

deselect it we get a very nice, clean result. [0:12:48] 

There are a couple of other differences to pay attention to.  If I select this element, the original one, and 

we open up its settings and go down to the Tags and Categories, you'll see that it came in immediately 

or came in from the IFC import with an ID that designated something about it, "NBL Sink Cleaner". And 

then IFC actually gives us a whole lot of things in here that describe its name and some of its dimensions 

here.  These are metric dimensions of course. [0:13:22]  

It turns out if you were to go in and change some of the dimensions like this, this is just text.  So it will 

not affect the model in any way.  The parameters that we are seeing here, we have a little bit of options 

for 2D - the line work - and 3D things.  But not a lot of controls in the basic element that was imported.  

If I select the object that I had created after turning this into morphs, you'll see that the IFC information 

is virtually empty.  I can click on Manage IFC Properties, and then I can manually go and add things into 

it; but nothing is going to actually bring in all of those attributes into this new object.  [0:14:17] 

I have even tried Apply Predefined Rule and it doesn't really do much other than designate this maybe 

as a plumbing fixture versus some other type of equipment.  But all those other attributes there could 

be added if you needed them. Most of the time for ArchiCAD users you simply want to bring in an 

element and have it show up properly in your model. And the IFC properties are not that consequential. 

But if you do need all of those IFC properties then you may want to actually retain it in the original form. 

Even though its 3D image may have lines on it, its symbol may not be as nice, but you would keep the 

IFC properties. [0:15:01] 

Notice up here that in the parameters, this object that I created has some options for fills, materials, and 

pens.  We'll look at that a little bit more later, but there is no place for you to put in things that show up 

in your schedule.  So I'm going to show you how you can change that.  How can you put in the types of 

listing parameters that would be typical in an appliance schedule or other types of schedules?  [0:15:27] 
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I will select this object and go to the File menu, Libraries and Objects, and say Open Object.  You can also 

use the keyboard shortcut Command+Option+O or Ctrl+Alt+O on Windows.  When I do that it opens up 

this object, and we can see under the parameters, those parameters that I was just playing around with 

- I am just showing you briefly.  Under details, which is what opened up when I first selected it, you will 

see that it says its subtype is model element. [0:16:04] 

That is very general type of subtype.  When I going to select subtype, I'm allowed to go and be more 

specific.  For example, instead of being in general model element, I maybe will designate it as an 

equipment element.  I can highlight this or I could be even more specific and say it's bathroom 

equipment because it's related to cleaning.  Now when I do that, whichever one I pick, when I say select, 

we don't see much change here, just the name changes.  But then if I go to parameters, you will see 

there are a whole lot more parameters that were added. [0:16:40] 

If you look carefully, it will talk about the note, remarks, manufacturer, location, accessories.  So these 

are the sort of things that will allow you to give you a space to put in information that would show up in 

a schedule.  So in the schedule for appliances or equipment, you can have these fields showing. And 

then having redesignated the subtype, this is going to be available.  So I am simply going to save the 

change of subtype for this NBL sink and close it. [0:17:16] 

And when I open up the settings for this again you'll see now there is parameters for listing. It's one of 

the IFC parameters.  And down here there are these elements or parameters that I can fill in and type in 

the manufacture or the cost.  So this is independent of the IFC properties, it is intended for use with 

ArchiCAD schedules.  By the way, we could add it to this element here.  In other words, we could open 

this and say open that object, and this is the imported one with all of the IFC, and I could change this 

again from model element, select the subtype, etcetera.  I won't bother; it will be exactly the same 

process. [0:18:02] 

The other question that Tim asked had to do with importing DWG files from manufacturers and what 

other formats we could do.  So let's take a look at this question.  He was talking about the Duravit 

website which has a nice looking hand basin, and that is available in a variety of formats.  When I use the 

link to open it up, we get this page here. And you'll see there are articles and technical drawings, but 

what we're interested in are the downloads.  If you click here it expands.  [0:18:38] 

Now we could pick up the 2D information from PDF or product images that are TIF; but what we really 

want are the 3D DWG. The IGS and STP are not files that we can read, and DXF is just another way of 

doing DWG information.  So really what we would want to do is just download the 3D DWG files and 

then save this which I've already done.  Now let me go back to ArchiCAD and import it.  So we can go to 

the File menu, File Special, Merge to do this, but I feel we get a little bit more control under File, 

Libraries and Objects, Open Object, because we are saying we want to open this particular file as an 

object.  [0:19:26] 
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When we do that we can pick something from our embedded library like the NBL Sink that I created or 

the original IFC import.  Now by the way, if we have something selected, when I say open library part, it 

will immediately open that definition.  What we want to do is have nothing selected and then we get 

choice.  We can go and browse for this.  And when I browse for it, you can see in my downloads folder 

that the Duravit download was a .zip file. And when it was expanded it just turned into this rather odd 

DWG.  The name is not very clear.  [0:20:05] 

But I can go ahead and open this.  Before I do that, I will point out that as a DWG file, it uses one of the 

translators, the preset translators that we've got.  So these are ones that are in my environment.  You'll 

probably have similar ones. There may be some other ones that you've created or edited. But if I go to 

the settings I want to point out two things that are of interest.  In recent versions of ArchiCAD, there's a 

certain point that Graphisoft added this option to pick up the drawing unit definition from the actual 

DWG file.  [0:20:41] 

This means that we don't need to set the drawing unit's size manually which we did previously.  So 

generally we want to use that wherever it works, otherwise this setting will determine how big the 

element is that is going to be coming in.  The other thing is that under the Open options here, the 3D 

information, in this case of the sink, will go directly into the object's GDL script which means that we 

could potentially look at it or edit things. Binary 3D is another way that it may actually be more efficient 

in some ways in use. But GDL I would generally use. [0:21:20] 

It will give some more flexibility, even if you don't take advantage of it, it probably doesn't slow things 

down. So the main thing is that we're using the DWG import for editable import, say Open this. And it 

will then bring up the partial open dialogue which is something that was added into ArchiCAD 14 that 

will allow you to bring in DWG files, only part of the layers if you didn't want all of the layers. In this 

case, as an object, I want everything, so I am going to say OK and bring in all of the layers. [0:21:53] 

It just went through conversion and you can see now it's an untitled object. When I go to the 3D view, 

we'll see that it does look like that sink.  In fact if I orbit around you can see that it is truly a nice 3D 

element.  The material is rather dark. We are going to change that after we place it because right now 

it's just picking up the pen.  This is drawn with a black pen, so it's a rather dark color there. So all I need 

to do is go to the File menu and say Save, and this will allow me to save this.  I will give it a name, say 

"Duravit Sink". It could be more specific if I want. And then say I would like to save it in the embedded 

library. [0:22:40] 

And when I click the save button I get an error message which surprised me the first time I saw this.  In 

version 16, because you can save objects to the BIMcomponent.com portal for other people to use, they 

insist that you choose what type of licensing.  Is this something you want to share freely or do you want 

to sell commercially? And you have to decide this as soon as you create it. So it didn't allow me to save 

it.  I have to go into this details area and change the license and pick one. [0:23:13] 
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Public Domain I think would make sense because this is something that we downloaded from the 

website, and I don't really own it. You can find out more about the different licensing terms here by 

clicking on this information button. It will open up a webpage that has a lot of information there.  Now 

having made that choice, I can go ahead and save, and again type in "Duravit Sink" and hit save. And 

now it will successfully complete that, and in a few seconds it will change the name here to Duravit sink. 

[0:23:44] 

Now I can close this up because I don't need to make any changes. Remember I could select the subtype 

if needed here and perhaps make this bathroom equipment here and select. And then I would want to 

go ahead and save this with the update.  That means that it would have the listing information for 

something going into a schedule.  Now I'm going to simply place this object here. You can see that it 

came in. It looks like it's the right size relative to the other sink. When I go to 3D we can see what it looks 

like. I will select this here and select that. [0:24:30] 

You can see it has odd handles. It's just sort of out of the bounding box area, but that that's fine. I can 

still select it. And one thing I may want to do is go under the model here since there are no controls in 

the main parameters area for the material. I might want to, instead of using object's materials where it 

came in with all this dark gray, I will say make it whitewash or perhaps make it a porcelain fixture.  And 

when I do that, you can see that it now looks quite a bit better.  [0:25:03] 

Now remember, right now its porcelain here but we have all of these extra facet lines which are ugly. 

And also if we go back to the original fixture here, you'll see that it did have a porcelain base but chrome 

or steel top.  So I would want to figure out a way to represent that better in ArchiCAD. Now I'm going to 

take this and clean up this symbol the same way I did with the other one by dragging a copy over here. 

And in the copy I'll go to the Design menu and say Convert Selection to Morph.  [0:25:43] 

That will allow me to have more control. So it gives me the same warning message saying that it's going 

to delete the original elements and any dimensions that were attached, but it also gives me an extra 

warning saying these morphs will be very complex and have a large number of polygons.  You can see 

that it is quite complex.  I will go ahead and say continue, but be aware that this may require some extra 

care on your part and you may not want to have dozens of these sinks all trying to be visualized in one 

view, because it can slow down ArchiCAD. [0:26:18] 

To know how detailed this is, how many polygons, I find it useful to use the Window, Palettes, Poly 

Count, Palette.  This is something that you can add on to ArchiCAD for free; it's available from the 

Graphisoft website.  If I select this element and refresh it, you can see that it has 21,000 polygons, that 

single sink. Then select the other sink here and refresh. You can see it's got 1,600.  So this one has close 

to 15 times as many polygons as the other one.  [0:26:58] 
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And now just to give it a comparison, if I go to the Object tool and pick a standard sink here and take 

let's say this mop sink which is similar and say OK, and drop it in and I select it and refresh, 382 polygons 

for that sink.  So the built=in ArchiCAD objects are much more efficient, they are designed for simple 

visualization and clean elevations, interior elevations particularly.  So just be aware that when you are 

bringing in manufacturer's elements, the poly count add-on will at least give you some guidance on that. 

[0:27:40]   

Now if I go to the Help menu, this is where you'll get that poly count add-on from the ArchiCAD 16 

downloads. In earlier versions it might be called ArchiCAD 10 or 12 goodies.  Because when I go to the 

downloads page what you'll see is that downloads, these are called goodies, they are add-odds that are 

available for ArchiCAD that aren't installed by default. And you can download Windows or Mac versions 

and read in this little Readme file how to install it here.  [0:28:11] 

Now let's go back and actually try to clean this up.  So I'll go and select these morph elements and look, 

there are 54 of them.  Wow, that's pretty incredible.  Now if I go and tell these elements to be soft 

instead of hard, remember, and say OK, let's take a look.  It's gotten a lot simpler.  You can see the result 

there.  When I go to 3D, you'll see that it's looking quite a bit better, but let's look at the issue that we 

have in this area here. [0:28:53] 

We can see it quite clearly that there are a number surfaces that obviously forming a smooth curve and 

it's got lines in between.  Why is that?  Well remember that it had so many different morphs, it was life 

54 different morphs. Let me just select several of them here.  So I'll just carefully select them one at a 

time.  And I found that after playing around with this a bit, that it can be very useful to select these.  You 

may have to zoom in very carefully so you don't overshoot.  [0:29:34] 

Basically I'm selecting all of these elements and maybe this one adjacent to it. And what I'll do is now 

use the option under the Design menu to modify morph union.  That means that it's going to unify all of 

these individual pieces into a single larger piece.  At first we won't see any change.  You can see that it 

still has all of these lines. But now when I select it, I select one element, and it is all of these ones.  If I 

select the morph element and change it to soft now, we are going to see that now it's cleaning up much 

better.  [0:30:16] 

So we might have to go in carefully and unify things that we need to.  But I found that it can actually be a 

problem if you unify too many things all at once or the wrong things, because ArchiCAD will start, as a 

morph, it may start to distort the shapes here.  Now I'm going to take these elements here. And I will 

point out that I've selected the tap, but it also selected something down below there.  It seems that this 

bottom element and this element here for some reason aren't unified.  Now I'm not going to worry 

about trying to clean that up for now.  [0:30:57] 
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 I'm just going to select these. And what I would like to do is change their material because remember 

that the bottom part basically was porcelain, but this upper part should be some type of metal.  And so I 

will go and perhaps change this to a simple chrome here.  And it will look a little bit different in 3D, but 

even more so, when I turn this into an object I will have more controls over it.  [0:31:25] 

Now I can go and clean up some more of this line work here but I'm not going to take the time for that. 

I'm simply going to go and take this slightly cleaned up element which is now still 45 separate morphs.  

But I'm going to go and turn this or create a copy of it as an object.  So Save Selection As, Object. We will 

call this "Duravit Sink Tap with Different Material".  So I'm just giving it a different name and the original 

element; it could be any name that you want.  [0:32:10] 

Now having done that, it then designates or shows me that I could have these materials parametric.  

And let's just say this porcelain; we will call this "basin". And under here, we will call this "tap".  And so 

now I'm labeling it as I like.  These are the new initial materials that it's going to record, but later on I can 

specify them.  So I will just say OK.  It has now saved that object.  I will go to the Object tool and place it 

here.  And now you can see when I have this placed, that this new object, I will go and say that I'd like to 

use the parameters to control the materials. Perhaps I want to make the tap, instead of chrome, just to 

demonstrate, maybe I will make it brass or bronze or some other thing.  [0:33:04] 

And you can see how it changed that material.  So this material now gives me control over the new 

object.  So I will say OK.  So we now have, if I go to 3D and zoom out a little bit, we now have the original 

DWG import, the set of morphs that have only been partially cleaned up, and the new object that has 

more capabilities including being able to change the material of the taps here. [0:33:41] 

So this concludes our tutorial on importing IFC and DWG elements from manufacturers through either 

general BIM websites like the BIM library in the UK and there are many others that you will find.  New 

ones come out it seems like every month or two.  And of course, manufacturers are starting to have 

more and more of these 3D objects, even just simply in DWG.  But the ability to be able to import these 

and clean them up, and incorporate them into schedules; because as we saw here, I can have the 

parameters for listing. I can easily add those in when I create that object or modify any object that's 

brought in here. [0:34:34] 

If I select this and use the Open Library Part, I can select the subtype. And by changing that to the 

appropriate one, then I'm going to have this element. And it will now have the parameters for listing, 

simply by changing that.  This concludes my lesson on importing IFC and DWG 3D library parts, pieces of 

equipment and furniture from manufacturers. This has been Eric Bobrow; I look forward to getting your 

comments and questions. Please post them on the page down below.  Thanks for watching. 

[END OF AUDIO 0:35:17] 


